
ASPEN Reports

Report Name File Name Summary  Access New in 

Release           
ACO / ARO Reports (41 Total)

Administrator Facility History 

(AFH) report                                 

(Accessible from multiple paths)

AdminFacHistory.rpt Lists the facilities where selected 

administrators have been employed. It 

includes identifying information for each 

facility and the administrator’s active dates at 

the facilities

*Reports → Administrator reports → 

Administrator Facility History (AFH)                          

*Directory View - Administration Directory → 

(Right click an administrator)  Quick Report → 

Administrator Facility History (AFH)

-

Administrator Survey Performance 

(ASP) report                     

(*Accessible from multiple paths)

SurveyPerformHistory.rpt Provides information about the surveys that 

have been conducted at facilities where 

selected administrators are or have been 

associated.

*Reports → Administrator reports → 

Administrator Survey Performance (ASP) 

*Directory View - (Right click an administrator) 

Quick Report → Administrator Survey 

Performance (ASP)

-

FMS Transactions Report (All 

Failed FMS transactions without 

success)

FMSTracking.rpt RO Mode only. Displays only those 

transactions for Federal Monitoring Survey 

(FMS) cases in a current failed state since 

the last successful upload.

Tracking → FMS Tracking… → FMS Reports 

Drop-down - All Failed FMS transactions without 

success
-

FMS Transactions Report (All 

FMS transactions)

FMSTracking.rpt RO Mode only. Lists all cases in Federal 

Monitoring Survey (FMS) tracking, including 

FMS Type, Extent, Event IDs, and pending 

upload status.

Tracking → FMS Tracking… → FMS Reports 

Drop-down - All FMS transactions
-

FMS Tracking report (ARO FMS 

Tracking Report)

FMSTracking.rpt RO Mode only. Displays the information in 

the Federal Monitoring Survey (FMS) 

Tracking window in report form, including 

Transaction details and upload status.

Tracking → FMS Tracking… → FMS Reports 

Drop-down - FMS Tracking Report
-

ASPEN Severity/Scope Grid 

report

OneSurvSS.rpt Presents all of the Scope/Severity details for 

a selected survey, in grid format.

Cert/Survey View → Expand Other Surveys - 

Survey Type → (Right Click)  Specific Survey → 

Print Forms... → S/S Grid

-

Certification Kit Report CertKit.rpt Displays list of facility Certification Kits, with 

an option of sorting the data in ascending or 

descending order alphabetically, or by survey 

date.

Tracking → Certifications → Print Tracking 

Report
-
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Facility Branch (FB) report Branch.rpt Lists the specific facility and details of any 

branches that are associated with that facility.

Expand Facility → (Right-click)  Affiliations node 

→ Quick Report → Facility Branch (FB) -

Facility Report Selection Criteria 

(Facility Directory (FD))

oFacdir.rpt Lists facilities with details about each. 

Including identifying information, emergency 

contact, and operating status.

Reports → Facility Reports → Facility Report 

Selection Criteria
-

Facility Information (FI) report oFacInfo.rpt Provides details from the facility record, 

including any buildings associated with the 

facility.

(Right click)  Facility Node → Quick Report → 

Facility Information (FI) -

Facility List (FL) report                

(Facility Quick List (FL)

FacilityList.rpt Line summary of information for facilities in 

the highlighted selection set.

My Selections Node → (Right click)  Selection 

Set → Quick Report → Facility List (FL) -

Full Facility Profile (FFP) report FacSurv.rpt Includes information about selected facility, 

administrators, and branches, with survey 

performance details.

Facility Node → Quick Reports → Full Facility 

Profile (FFP) -

HHA Branch Report              

(Home Health Agency Providers 

with Branches Defined)

HHABRANCH.rpt Lists details for Home Health Agency (HHA) 

facilities that have Branches defined.

Reports → Facility Reports → Provider 

Affiliations → HHA Branch Report -

Hospital/CAH Medicare (And 

Medicaid - If Applicable ) Database 

Worksheet

FormWKST.rpt In-house worksheet that shows general 

information about the facility, CLIA numbers, 

and accreditation status.

Certification Kit → Application Worksheet → 

Print -

Hospital Offsite and Affiliation 

Report                               

(Hospital Providers with Offsite 

and Affiliation Locations)

HospOffsiteAffiliation.rpt Lists details for hospital providers with offsite 

and affiliation locations.

Reports → Facility Reports → Provider 

Affiliations → Hospital Offsite and Affiliations 

Report
-

NPI By Number report NPINumber.rpt Displays facility details and National Provider 

Identifier (NPI) numbers in ascending order 

by NPI number.

Reports → NPI Reports → NPI By Number

-

NPI By Provider report NPIProvider.rpt Displays facility details and National Provider 

Identifier (NPI) numbers in ascending order 

by CMS Certification Number.

Reports → NPI Reports → NPI By Provider

-

OPT Extensions Report 

(Outpatient Physical Therapy 

Providers with Extension Location)

OPD_Extension.rpt Lists the Outpatient Physical Therapy (OPT) 

providers with extension locations 

information, including any approved/opened, 

terminated, and accepted data.

Reports → Facility Reports → Provider 

Affiliations → OPT Extensions Report

-
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Owner Facility History (OFH) 

report                           

(*Accessible from multiple paths)

OwnerFacHistory.rpt Lists the facilities owned by selected owner 

companies currently and in the past, including 

identifying information for each facility and the 

owner company’s dates of ownership.

*Reports → Owner Reports → Owner Facility 

History (OFH)                                          

*Directory View - Ownership Directory → (Right 

click an organization)  Quick Report → Owner 

Facility History (OFH)

-

Owner Survey Performance (OSP) 

report                                            

(*Accessible from multiple paths)

OwnerSurveyPerform.rpt Provides information about the surveys that 

have been conducted at facilities owned by 

selected owner companies.

*Reports → Owner Reports → Owner Survey 

Performance (OSP)                                        

*Directory View - Ownership Directory → (Right 

click an organization)  Quick Report → Owner 

Survey Performance (OFH)

-

Personnel Master List (PML) 

report

oPersons.rpt List of staff members with contact 

information.

Directory View - (Right click)  Staff Directory → 

Quick Report → Personnel Master List (PML) -

Quick Report oQuickRpt.rpt Multiple options. Displays selected 

information for a specific survey.

Survey Node → (Right click)  Survey → Print 

Forms → Quick Report
-

Regulation Set (RS) report oRegSet.rpt Displays properties, definitions, interpretive 

guidelines and, optionally, custom help, for 

each tag in the selected regulation set.

Regulation - Active Only Node → (Right-click) 

Quick Reports → Regulation Set (RS) -

Report Usage Summary ReportUsageSummary.rpt Displays list of dates/times printed for all 

ACO/ACTS reports by ID number and name. 

The SA Report Usage Summary report 

displays the data for the current state.  The 

RO Report Usage Summary report provides  

the option to display data for the current state 

or for all states. 

Reports → Report Usage Summary

-

Severity/Scope Detail (SSD) report 

(Scope/Severity Detail SSD)

SSSummary.rpt Shows the distribution of citations by 

severity/scope rating during the given time 

period, and indicates the facility(s), survey 

event ID, survey date, and surveyor for each 

citation.

Reports → Survey History Reports → 

Severity/Scope Detail

-

Severity/Scope Summary (SSS) 

report (Scope/Severity Summary 

SSS)

SSSummary.rpt Summarizes the distribution of citations by 

severity/scope rating during the given period 

of time.

Reports → Survey History Reports → 

Severity/Scope Summary -

Citation Detail (STF2) report (Staff 

Citation Detail (STF2)  - 

Accessible from multiple paths)

CitationDetail.rpt Includes all information in the Survey 

Summary report as well as a list of tags cited 

by each surveyor.

*Reports → Surveyor Reports → Citation Detail 

(STF2)                                                          

*Directory View - (Right Click) Staff Directory    

→ Quick Report → Citation Detail (STF2)

-
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Tag Frequency (STF3) report 

(Staff Citation Frequency (STF3)    

- Accessible from multiple paths)

TagFrequency.rpt Lists tags cited by selected surveyors during 

the given time period and shows citation 

frequency along with severity and scope. You 

can choose to sort by tag ID or by frequency.

*Reports → Surveyor Reports → Tag Frequency 

(STF3)                                                          

*Directory View - (Right Click)  Staff Directory → 

Quick Report → Tag Frequency (STF3)
-

Survey Summary (STF1) report     

(Staff Survey Summary (STF1) - 

Accessible from multiple paths)

SurveySummary.rpt Presents summary information for surveys 

conducted by selected surveyors during the 

specified period of time. Does not include 

surveys with only 0000, 9999, or 9999K tags 

OR tags that have been corrected in 

subsequent surveys, or surveys where no 

citations were cited by selected surveyor.

*Reports → Surveyor Reports → Survey 

Summary (STF1)                                    

*Directory View - (Right Click)  Staff Directory    

→ Quick Report → Survey Summary (STF1) -

Tag Details (TAG2) report       

(Tag Detail Report (TAG2))

TagDetail.rpt Includes all information in the Tag Summary 

report as well as the surveyor who issued 

each citation and percentage of total citations 

for the tag issued by that surveyor.

Reports → Regulation Reports → Tag Details 

(TAG2)

-

Tag Summary (TAG1) report TagSummary.rpt Lists the number of citations issued during the 

specified time period for selected regulations. 

Average severity and scope are also listed for 

each citation.

Reports → Regulation Reports → Tag Summary 

(TAG1)
-

Transactions Report TransactionTracking.rpt Lists upload transactions for a specified 

period. There are numerous selection options 

for transactions, including an RO quick list of 

initial and flagged kits.

Tracking → Transactions → OK → PRINT

-

Transactions Report - CLIA - All 

Failed Transactions without a 

Follow-up Success

TransactionTracking_CLIA.rpt Lists upload transactions for which CLIA 

uploads failed and the follow-up action was 

unsuccessful during a specified period. 

Tracking → Transactions → (Drop-down menu) 

CLIA - All Failed Transactions without a Follow-

up Success option → PRINT
-

Work Unit Roster (TR) report TeamRoster.rpt Provides details about the selected Work Unit 

and a list of its members, with details from the 

employee file. You can generate the report for 

all Work Units as well.

Directory View → (Right click)  Work Unit Node -

or- (Right click)  specific Work Unit → Quick 

Report → Work Unit Roster (TR) -
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(Letter Title Specific) By Group

-

Allows you to view/generate a letter from the 

letter directory for a group of recipients; 

Based on select facility information.

Reports → Form Letters → By Group…

-

(Letter Title Specific) Custom
-

Allows you to view/generate a letter from the 

letter directory for selected facility recipients.

Reports → Form Letters → Custom Select…
-

Batched Letters for <User Name>

-

Displays a list of batched letters either for the 

current user, or from a custom user list 

defined by the user. 

Reports → Print Batched Letters…

-

Change of Status report ChangeofStatus.rpt Lists facilities with at least one change of 

status, and lists the related change of status 

certification kits, dates, CCN, and ASPEN 

facility type in effect, both prior to and after 

the change of status.

Reports → Facility Reports → Change of Status

10.2

Regional Reports

-

RO Mode Only. Offers a list of enforcement 

reports that display data across all states in 

the selected region. The configuration options 

are the same as the corresponding state 

reports.

Reports → Regional Reports...

10.6

CDC Compliance Report CDC_NursingHomeMonitoring.rpt RO Mode Only. A report format of the CDC 

Reporting enforcement Manager window. 

Displays facility information, CDC reporting 

compliance status, and Civil Money Penalties 

for facilities across all regions.

Tracking → CDC Enforcement → View 

Reports...

Alternate path - CDC ENF toolbar button → View 

Reports

11.9.2

Special Survey Report SpecialSurvey.rpt Provides details about special surveys such 

as facility information, survey event ID, type, 

extent, and survey team composition.

Reports → Special Survey Report

11.9.2
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LTCSP Documentation Reports 

(confidential) (7 Total)

Surveyor Notes LTCSPSurveyorNotes.pdf Lists all surveyors by name (last name, first 

name) and ID. Lists any notes surveyors 

recorded.

ACO → NH → Surveys → right-click a survey → 

LTCSP Documentation Reports (confidential) → 

Surveyor Notes
11.2

Team Meeting Notes LTCSPTeamMeetingNotes.pdf Lists the full text of the LTCSP application, 

including indication of date option (day1, 

day2, or later), values entered by the TC, and 

any available notes.

ACO → NH → Surveys → right-click a survey → 

LTCSP Documentation Reports (confidential) → 

Team Meeting Notes 11.2

Initial Pool Data LTCSPInitialPool.pdf Lists Care Area descriptions, RI, RRI, RO 

and RR responses for each Care Area, 

including blank responses, documentation for 

each Care Area, and MDS Discrepancy, if 

checked.

ACO → NH → Surveys → right-click a survey → 

LTCSP Documentation Reports (confidential) → 

Initial Pool Data 11.2

Resident Investigation Data LTCSPInvestByInvest.pdf Lists residents investigations. If sorted by 

Investigative Area (default), report is sorted 

by investigative area with associated 

residents (last name, first name) under that 

area. If sorted by Resident, report is sorted by 

resident (last name, first name), with 

associated investigations listed.

ACO → NH → Surveys → right-click a survey → 

LTCSP Documentation Reports (confidential) → 

Resident Investigation Data

11.2

Facility Task Data LTCSPFacilityTask.pdf Lists Facility Tasks, the surveyors (name and 

ID) assigned to the Facility Task, and the 

residents (last name, first name).

ACO → NH → Surveys → right-click a survey → 

LTCSP Documentation Reports (confidential) → 

Facility Task Data

11.2
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Potential Citation Data LTCSPPotentialCite.pdf For Cited and Non-Cited Tags, displays 

- Tag , tag description and scope severity 

- Investigative areas and residents where CE 

response was No

- Residents that were selected for inclusion 

(last name, first name, (ID)

- Surveyor who performed the investigation 

(last name, first name (ID))

- Severity for the specific resident / CA with 

description

Additionally, for Non-Cited tages, displays the 

reason/rationale for not citing.

ACO → NH → Surveys → right-click a survey → 

LTCSP Documentation Reports (confidential) → 

Potential Citation Data

11.2

Federal Monitoring Survey 

Documentation Report

LTCSPFMSurvey.rpt RO Mode only. Lists deficiency information 

from SA/RO surveys. Including, initial pol, 

sample selection, investigation, and facility 

task results.

ARO → NH → Surveys → right-click survey → 

LTCSP Documentation Reports (confidential) → 

Federal Monitoring Survey 11.5
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STAR Reports (6 Total)

Surveyor Page Notes Survey 

Documentation Report

STARSurveyorNotes.rpt Displays details of any notes created by 

surveyors in the Page Notes section of the 

associated STAR survey.

Cert/Survey View → STAR Survey (Right Click) 

STAR Reports (confidential) → Surveyor Page 

Notes option
-

Staff List Survey Documentation 

Report

STARStaffList.rpt Displays survey team members and names of 

those interviewed for the survey. Also 

includes the facility name, event ID, and 

survey exit date

Cert/Survey View → STAR Survey (Right Click) 

STAR Reports (confidential) → Staff List option
-

Patient List Survey Documentation 

Report

STARPatientList.rpt Displays a list of patient names and labels 

interviewed for the survey. Also includes 

facility name, event ID, and survey exit date.

Cert/Survey View → STAR Survey (Right Click) 

STAR Reports (confidential) → Patient List 

option
-

Survey Data Survey 

Documentation Report

STARSurveyData.rpt Displays full survey data grouped by surveyor, 

including question text, answers, findings, 

tags, and whether the answer indicates a 

concern.

Cert/Survey View → STAR Survey (Right Click) 

STAR Reports (confidential) → Survey Data 

option
-

Potential Citation Data Survey 

Documentation Report

STARPotentialCitations.rpt Lists tag information, including tag ID, tag 

title, number of times triggered, and whether 

or not tag was cited. For cited tags, includes 

STAR citation write-up data.

Cert/Survey View → STAR Survey (Right Click) 

STAR Reports (confidential) → Potential Citation 

Data option
-

Report Summary Survey 

Documentation Report

STARReportSummary.rpt This report prints every time one or more of 

the Survey Documentation sub-reports are 

generated, and displays the following 

information: CCN, facility name and address, 

survey exit date, STAR data, each sub-report 

with a Yes/No indicator of whether the report 

was generated, and the criteria used for 

generated sub-reports.

Cert/Survey View → STAR Survey (Right Click) 

STAR Reports (confidential) → Any STAR Data 

option

-
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AST Reports (30 Total)

Pending/Initial Aging Report 

History

AST_PendingAging.rpt Provides facility name, address, type, phone, 

email, and active date information for a 

selected administrator.

Reports → Scheduling & Tracking Reports → 

Tracking Report → Pending/ Initial Aging Report -

Branch Office report HHABranch1.rpt Provides basic information on the branch 

offices associated with an HHA, as entered 

on CMS-1572A.

Reports → Scheduling and Tracking Reports → 

Profile Reports → Branch Office -

Schedule Calendar Report ASTCalendar.rpt Lists scheduled certifications and 

recertifications in a standard calendar format.

AST → Calendar → Print → Schedule Calendar 

Report -

Facility Milestone report AST_Milestones.rpt Details all of the certification milestones for 

the user-selected facilities, including provider, 

survey, IDR, 2567, and POC tracking 

information. Also includes information 

regarding any Transfer to OSCAR (Upload) 

transactions.

Reports → Scheduling & Tracking Reports → 

Tracking Report → Facility Milestone

-

Certifications to be Scheduled 

report

AST_CertToBeScheduled.rpt Lists facilities/providers with certifications yet 

to be scheduled, including most recent and 

target certification survey dates.

Reports → Scheduling & Tracking Reports → 

Scheduling Reports → Certifications to be 

Scheduled
-

Change of Ownership Profile 

report (Change of Owner Tracking 

Profile)

AST_ChowProfile.rpt Detailed process of selected facility/provider 

ownership changes.

Reports → Scheduling & Tracking Reports → 

Profile Reports → Change of Ownership Profile -

CHOW Tracking report AST_ChowChangeOwnerTracking.rpt Provides the Change of Ownership (CHOW) 

processing steps for a facility/provider.

Reports → Scheduling & Tracking Reports → 

Tracking Report → CHOW Tracking -

CHOW Processing Time report AST_ChowProcessTimes.rpt Defines the average number of days elapsed 

during the steps required for change of 

ownership (CHOW) processing.

Reports → Scheduling & Tracking Reports → 

Tracking Report → CHOW Processing Time
-

Complaint to be Scheduled report 

(Complaint Investigations to be 

Scheduled)

AST_CompToBeScheduled.rpt Lists information about intakes requiring a 

complaint investigation that is not yet 

scheduled, including provider/facility and 

complainant information.

Reports → Scheduling & Tracking Reports → 

Scheduling Reports → Complaints to be 

Scheduled
-

Tracking - Comprehensive report 

(Comprehensive Survey 

Scheduling Report)

AST_ComprehensiveSS.rpt Lists a scheduling report of all comprehensive 

surveys for selected time frame, including 

provider & facility information, most recent 

and target certification dates, and number of 

pending complaints.

Reports → Scheduling & Tracking Reports → 

Tracking Report → Tracking-Comprehensive

-
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CoPs Out of Compliance report AST_CoP.rpt Details out-of-compliance conditions of 

participation (COPs) for each selected facility.

Reports → Scheduling & Tracking Reports → 

Tracking Report → CoPs out of compliance -

Full Facility Profile (FFP) report oFacSurv.rpt Profile report presents comprehensive 

information about each facility/provider 

selected for the report, including basic facility 

properties information and survey 

performance history.

Reports → Scheduling and Tracking Reports → 

Profile Reports → Full Facility Profile (FFP)

-

Survey Overdue (HHA) report AST_HHASurveyOverdue.rpt Details Home Health Agencies (HHAs) that 

are overdue for a survey.

Reports → Scheduling & Tracking Reports → 

Tracking Reports → Survey Overdue (HHA) -

Initial Certification Processing 

Time report

AST_CertificationProcessTimes.rpt Details the average number of days elapsed 

for specific actions during initial certification 

processing, including number of sampled 

providers.

Reports → Scheduling & Tracking Reports → 

Tracking Reports → Certification Processing 

Time → Initial Certification Processing Time
-

Initial Certification Profile report 

(Initial Provider Certification 

Tracking Profile)

AST_InitialCertProfileSA2.rpt Provides information and status on the 

certification process for the providers selected 

for the report.

Reports → Scheduling & Tracking Reports → 

Profile Reports → Initial Certification Profile -

Involuntary Termination 23 Day 

report 

AST_InvolutaryTermination23.rpt Lists providers involuntarily terminated within 

23 days of being notified of non-compliance.

Reports → Scheduling & Tracking Reports → 

Tracking Reports → Involuntary Termination 23 -

Involuntary Termination 90 Day 

report

AST_InvolutaryTermination90.rpt Lists providers involuntarily terminated within 

90 days of being notified of non-compliance.

Reports → Scheduling & Tracking Reports → 

Tracking Reports → Involuntary Termination 90 -

Termination (90 Days) report 

Termination (23 Days) report 

(Involuntary Termination (90 

Days)) / (Involuntary Termination 

(23 Days))

AST_Termination.rpt Lists providers terminated within 90 or 23 

days, respectively, of non-compliance 

notification.

Reports → Scheduling & Tracking Reports → 

Profile Reports → Involuntary Termination (90 

Days) / (23 Days) -

Months Since Last Certification 

report

AST_MonthsSinceLastCert 

Report.rpt

Lists facility/provider information and the date 

of their most recent certification, including 

time interval, and the date the current 

certification (If applicable) is scheduled or in 

progress.

Reports → Scheduling and Tracking Reports → 

Scheduling Reports → Months Since Last 

Certification -

Overdue Revisit report AST_RevisitOverdue.rpt Details of facilities that have an overdue 

required revisit.

Reports → Scheduling & Tracking Reports → 

Tracking Reports → Overdue Revisits -

Recertification Processing Times 

report 

AST_ReCertificationProcessTimes.rpt Details the average number of days elapsed 

for specific actions during recertification 

processing, including the number of sampled 

providers.

Reports → Scheduling & Tracking Reports → 

Tracking Reports → Certification Processing 

Time → Recertification Processing Time
-
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Recertification Profile report 

(Recertification Provider 

Certification Tracking Profile)

AST_RecerCertProfileSA.rpt Provides recertification status and information 

for each provider selected for the report.

Reports → Scheduling & Tracking Reports → 

Profile Reports → Recertification Profile -

Revisits to be Scheduled report AST_RevToBeScheduled.rpt Details of facilities that require revisit surveys 

that are not yet scheduled.

Reports → Scheduling & Tracking Reports → 

Scheduling Reports → Revisits to be Scheduled -

Scheduled Surveys by Facility 

(*Schedule Detail Report - 

Accessible from multiple paths)

AST_ScheduleDetail.rpt Provides details of scheduled surveys and 

survey team for a user-defined period.

*Reports → Scheduling & Tracking Reports → 

Scheduling Reports → Scheduled Survey Report 

by Period → Scheduled Surveys by Facility                                                                  

*AST → Calendar → Print → Schedule Detail 

Report

-

Scheduled Surveys by 

Surveyor/Team report

AST_ScheduleSurveyor.rpt List of surveys currently scheduled by either 

surveyor or survey team.

Reports → Scheduling and Tracking Reports → 

Scheduling Reports → Scheduled Survey Report 

By Period → Scheduled Surveys by 

Surveyor/Team

-

Survey Average Report      

(Survey Average Interval Report) 

AST_SurveyAverageIntervalReport.rpt Details the number of months since the last 

certification for a user-defined set of providers 

and time parameters.

Reports → Scheduling & Tracking Reports → 

Scheduling Reports → Survey Average Report -

Surveys Awaiting Acceptable Plan 

of Correction report

AST_POCTracking.rpt Lists facilities that have received at least one  

survey indicating deficiencies, and have yet to 

supply an acceptable Plan of Correction 

(POC) indicating how they will correct those 

deficiencies.

Reports → Scheduling & Tracking Reports → 

Tracking Reports → POC Tracking

-

Surveys Awaiting Revisits report 

(Revisit Due Date) 

AST_AwaitingRevisits.rpt Details facilities/providers with scheduled 

survey revisits that have not yet occurred.

Reports → Scheduling & Tracking Reports → 

Tracking Report → Revisit Due Date
-

Scheduling - Target Month (Target 

Certification Month Report)

AST_TargetCertMonth.rpt Details a user-selected set of providers, 

providing their last certification dates, their 

target scheduled dates, how much time has 

passed since their last certification, and 

whether they have been scheduled for their 

next certification.

Reports → Scheduling & Tracking Reports → 

Scheduling Reports → Scheduling Target Month

-

Termination Summary Report TerminationSummary.rpt Details the number of terminations for the 

selected facilities/providers, broken down by 

termination type and facility/provider category.

Reports → Schedule & Tracking Reports → 

Tracking reports → Termination Summary Report
-
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ACTS Reports (Quick Reports - 20 Total)

Action Item Report ActionItem.rpt Lists all action items assigned to the user, 

including the current status and date of most 

recent activity.

Tree View → (Right Click)  My Action Items → 

Quick Report -

Allegation Detail Report AllegationDetail.rpt Four print options - Non-EMTALA/Non-

Deemed Allegation Detail Report, EMTALA 

Allegation Detail Report, Deemed Allegation 

Detail Report and EMTALA/Deemed 

Allegation Detail Report. Displays basic intake 

information and allegation details including 

category, subcategory, and findings, for 

selected criteria.

Facility Tree View (Right Click)  a Facility → 

Quick Report → Allegation Detail Report

-

CMS-1541A Form FORM CMS-1541A Displays the Federal CMS-1541A form for the 

selected intake.

(Right Click)  an Intake → Quick Report → CMS 

1541A Form
-

CMS-2802 Form FORM CMS-2802 Displays the Federal CMS-2802 form for the 

selected intake.

(Right Click)  an Intake → Quick Report → CMS 

2802 Form
-

CMS-562 Form FORM CMS-562 Only available for pre-ASPEN 10.1.7 

investigation surveys. Displays the CMS-562 

Medicare/Medicaid/CLIA Complaint Form.

(Right Click)  an Intake → Quick Report → CMS 

562 Form
-

Complaint/Incident Investigation 

Report

Invest.rpt Displays detailed information about the 

provider, intake, complainants, residents, 

perpetrators, allegations, and investigation. It 

also indicates whether deficiencies are linked.

(Right Click)  an Intake → Quick Report → 

Investigation Report

-

Complaint/Incident Survey Report InvestSummary.rpt Displays provider, survey, complaint/incident, 

allegation, citation, and activity information for 

all intakes linked to the same investigation as 

the selected intake. 

(Right Click)  an Intake → Quick Report → 

Investigation Survey Report

-

Complainant History report Invest.rpt Displays detailed information about all the 

intakes and associated investigations, 

including survey and provider information, 

that include the selected complainant. 

Facility Tree View → Complainants → (Right 

Click)  a Complainant → Quick Report → 

Complainant Intake History -

Complainant Intake Summary 

report                                   

(Complainant Intake Listing)

ClainSum.rpt Lists all the intakes that include the selected 

complainant, and provides basic intake, 

provider, and investigation information.

Facility Tree View → Complainants → (Right 

Click)  a Complainant → Quick Report → 

Complainant Intake Summary
-
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Deemed Provider Report Deemed.rpt Displays selected provider information, and 

lists any intakes and their associated data.

(Right Click)  Facility → Quick Report → Deemed 

Provider Report -

Facility History w/Names (F01) 

report

Invest.rpt (F01) Lists intake details for the selected 

facility/provider for the specified time period, 

including activities,  investigations, and 

identifies individuals associated with the 

intake.

(Right Click)  Facility → Quick Report → Facility 

History w/Names (F01)

-

Facility History, No Names (F02) 

report

SummPv.rpt (F02) Lists intake details for the selected 

facility/provider for the specified time period, 

including activities,  investigations, without 

names of any individuals associated with the 

intake.

(Right Click)  Facility → Quick Report → Facility 

History, No Names (F02)

-

Facility Status report FacilityStatus.rpt Provides facility/provider identification 

information and operating status, including, 

as available, administrator information, bed 

count, and building information.

(Right Click)  Facility → Quick Report → Facility 

Status
-

Facility Summary (F03) report ComplaintTrackingLog.rpt Lists detailed information of intakes for the 

selected facility/provider, including intake 

numbers and status, allegations, findings, 

cited deficiencies (except memo tags 0000, 

9999, and 999K), etc. 

(Right Click)  Facility → Quick Report → Facility 

Summary (F03)

-

Hotline Call Detail Report Hotline.rpt Displays details about the selected call and 

intake (if applicable), including any associated 

notes.

Facility Tree View → Hotline → (Expand) a 

Hotline Category → (Right Click)  Selection → 

Quick Report
-

Hotline Log report HotlineComplaintLog.rpt Lists all calls received on the Hotline during 

the specified time period by all or selected 

Hotline staff members. Details such as caller 

name and call category are provided. 

Includes any notes.

(Right Click)  Hotline → Quick Report

-
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Incident/Complaint Summary 

report

SummPV.rpt Displays a summary of information for the 

public about the selected intake; titled 

Complaint Summary or Incident Summary as 

appropriate.

(Right Click)  Intake → Quick Report → 

Summary - Non-confidential
-

Intake Information report Intake.rpt Displays detailed information about the 

selected intake, including provider, 

complainant, and activity data, as well as any 

associated intakes.

(Right Click)  Intake → Quick Report → Intake 

Information
-

Intake Notes report IntakeNotes.rpt Identifies the intake and provider information, 

including any supplementary notes entered 

about the complaint/incident.

(Right Click)  Intake → Quick Report → Intake 

Notes -

Restraint/Seclusion Facility Death 

Report

FacResSecl.rpt Displays provider information, and details of 

any intakes resulting in death associated with 

restraint/seclusion.

(Right Click)  Facility → Quick Report → 

Restraint/Seclusion Death Report (F04) -
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ACTS Reports (Menu Reports - 40 Total)

Agency Referral Summary Report AgencySumm.rpt Lists provider name and contact information, 

as well as any intake details, sorted by 

agencies to which the intake was referred.

Reports → Agency Referral Summary Report

-

Allegation Detail Report AllegationDetail.rpt Four print options - Non-EMTALA/Non-

Deemed Allegation Detail Report, EMTALA 

Allegation Detail Report, Deemed Allegation 

Detail Report and EMTALA/Deemed 

Allegation Detail Report. Displays basic intake 

information and allegation details including 

category, subcategory, and findings, for 

selected criteria.

Reports → Allegation Detail Reports

-

Complaint/Incident Allegation 

History report

ComplaintHistory.rpt Displays allegation information in both 

graphical and text form. Allows you to 

combine or separate provider types, and 

provide details of, or summarize the report 

data.

Reports → Complaint/Incident Allegation History

-

Complaint/Incident Assignment 

Listing report

ComplaintLog.rpt Lists assigned intakes and provides 

information including provider name and ID, 

intake number, assigned and received end 

dates, priority, survey exit date and ID, 

responsible SA and RO, and investigator or 

scheduler name(s).

Reports → Complaint/Incident Assignment 

Listing

-

Complaint/Incident Investigation 

Log report

LogFac.rpt Provides detailed information about 

investigations, including intake number, 

priority, survey start and exit dates, findings, 

condition-level tags, IJ tags, etc.

Reports → Complaint/Incident Investigation Log

-

Non-Deemed Provider - 

Immediate Jeopardy Federal 

Incidents Investigation Timeframe 

Report

InvestTimeframeIJ.rpt Provides investigation timeliness data for 

incident intakes with a Priority of A - IJ 

involving non-deemed providers.

Reports → Federal Only → Federal Investigation 

Timeframe Reports → IJ → Non-Deemed 

Provider Incidents
-

Death-Restraint/Seclusion report 

(Death Associated with the Use of 

Restraint/Seclusion Report)

RestraintSeclusion.rpt Lists details of any deaths associated with 

restraint and/or seclusion, including intake 

number, whether death occurred while 

restrained, secluded, or both, relevant dates, 

etc.

Reports → Death -Restraint/Seclusion

-
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Deemed Provider Report DeemedAll.rpt Lists intakes for deemed providers with basic 

provider and intake information, including 

relevant dates, allegations, findings, tags 

cited, and other totals.

Reports → Deemed → Deemed Provider Report Available as 

Regional 

Report in 

11.0

Deemed Provider RO Response 

to Survey Start Interval report

DeemedInterval.rpt There are three interval options for this report; 

Regardless of Interval, RO Response to 

Survey Start, or Exit dates, then select 

number of days to use for interval.  Lists 

Deemed intakes that exceed the specified 

interval.

Reports → Deemed → Deemed Provider RO 

Response to Survey Start Interval

-

EMTALA Interval Report EmtalaInterval.rpt There are three interval options for this report; 

Regardless of Interval, RO Response to 

Survey Start, or End dates, then select 

number of days for interval.                   

Report lists EMTALA intakes that exceed the 

specified interval.

Reports → EMTALA → EMTALA Interval Report

-

EMTALA Tracking Report Emtala.rpt Displays detailed information about EMTALA 

intakes; Including receipt date, provider 

information, alleged EMTALA violation, date 

investigation completed, RO confirmation and 

response, resolution, etc.

Reports → EMTALA → EMTALA Tracking Report

-

Federal Intakes report FederalIntakes.rpt Lists Federal intakes (those linked to a 

Federal survey) for the specified time period. 

Includes the following fields: Intake Number, 

Provider Name and Number, Facility ID, 

Intake Type, Priority, Event ID, Received 

Start Date, and Received End Date.

Reports → Federal Only → Federal Intakes

-

Deemed Provider - Immediate 

Jeopardy Federal Investigation 

Timeframe Report

InvestTimeframeIJDeemed.rpt Displays investigation timeliness data for  

intakes with a Priority of A - IJ involving 

deemed providers.

Reports → Federal Only → Federal Investigation 

Timeframe Reports → IJ → Deemed Provider -

Deemed Providers - Non-

Immediate Jeopardy Federal 

Investigation Timeframe Reports

InvestTimeframeDeemed.rpt Displays investigation timeliness data for non-

IJ intakes involving deemed providers, for 

which an investigation was approved, 

including provider name and number, RO 

approval date, Investigation due date, Survey 

start and exit dates, and days between RO 

approval and survey start/exit dates.

Reports → Federal Only → Federal Investigation 

Timeframe Reports → Deemed Providers - Non-

IJ

-
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EMTALA Intakes: Federal 

Investigation Timeframe Report

InvestTimeframeEmtala.rpt Displays investigation timeliness data for 

EMTALA intakes, including Intake Number, 

Provider Name and Number, Received Start 

Date and End Date, RO Approval date, 

Investigation Due date, and Survey Start and 

Exit dates.

Reports → Federal Only → Federal Investigation 

Timeframe Reports → EMTALA Intakes

-

Long Term Care: Non IJ 

High/Medium Federal Investigation 

Timeframe Reports

InvestTimeframeNonIJ.rpt Provides investigation timeliness information 

for non-IJ High/Medium intakes involving 

Nursing Homes.

Reports → Federal Only → Federal Investigation 

Timeframe Reports → Long Term Care → Non-IJ 

High/ Non-IJ Medium
-

Hotline Call Summary report HotlineCalls.rpt Lists hotline calls sorted by category for each 

month within the specified year, including 

monthly and category totals.

Reports → Hotline Call Summary

-

Incidents Resulting in Deficiencies 

Detail report

IncidentsResultingDetail.rpt Lists providers with incidents resulting in 

deficiencies, including intake number, survey 

start and exit dates, notification date, 

deficiencies cited, and activity completion 

dates.

Reports → Deficiency Reports →  Incidents 

Resulting in Deficiencies → Incidents Resulting 

in Deficiencies Detail -

Incidents Resulting in Deficiencies 

Summary report

IncidentsResultingSummary.rpt Lists provider details and totals of incidents 

resulting in deficiencies for each provider.

Reports → Deficiency Reports →  Incidents 

Resulting in Deficiencies → Incidents Resulting 

in Deficiencies Summary
-

Intake Interval Report            

Intake Accredited Interval Report

Interval.rpt Shows the number of days interval between 

the Received End Date and the Investigation 

Due Date, for each intake. It also provides 

Survey Start and End Dates, and indicates 

Priority. 

Reports → Interval Report → Intake Interval 

Report / Intake Accredited Interval Report

-

Intakes without Scheduled 

Surveys

IntakesPendingInvest.rpt Lists data for intakes that require an 

investigation survey, but do not have a linked 

survey (marked as Selected on the 

Investigation tab), including received end and 

investigation due dates, and calendar days 

remaining and overdue. You can group by 

None, Priority, Provider Type, or Responsible 

Team.

Reports → Intakes without Scheduled Surveys

-

Investigations Lacking Survey 

Upload report

 Lack562Upload.rpt Lists investigations with no record of a survey 

(CSP-SRV) upload being attempted, including 

the number of days between the survey start 

and exit dates, and the received start and end 

dates.

Reports → Federal Only → Investigations 

Lacking Survey Upload

-
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Non-Deemed Provider - 

Immediate Jeopardy Federal 

Complaints Investigation 

Timeframe Report

InvestTimeFrameIJ.rpt Displays investigation timeliness data for 

complaint intakes with a Priority of A - IJ 

involving non-deemed providers.

Reports → Federal Only → Federal Investigation 

Timeframe Reports → IJ → Non-Deemed 

Provider Complaints
-

Outstanding Activities report OutInvestAct.rpt Lists activities, as defined on the Activities 

tab, assigned but not yet completed, with 

associated intake details, including activity 

type, assigned and due dates, and 

responsible staff.

Reports → Outstanding Activities

-

QE 562 Log report (Quick Entry 

562 Log)

QE562Log.rpt Lists Quick Entry (QE) 562 records for a 

specified time frame, including provider 

information, Survey Exit Date, Recipient of 

complaint/incident report, investigating 

agency, and upload status.

Reports → QE 562 Log

-

Substantiated Complaint by 

Provider report

Substantiated.rpt Lists totals of substantiated complaints for a 

specified period of time sorted by facility ID 

and provider name, including total number of 

intakes and total number of intakes linked to 

Federal deficiencies.

Reports → Substantiated Reports → 

Substantiated Complaint by Provider

-

Substantiated Complaint Detail 

report

SubstantiatedDetail.rpt Lists details of substantiated complaints for 

the specified period of time, including intake 

number, priority, cited deficiencies (except 

memo tags 0000, 9999, and 999K), activities, 

and other information.

Reports → Substantiated Reports → 

Substantiated Complaint Details

-

Timeliness Report Resolution.rpt Shows those intakes that exceed the user-

specified number of days interval for one of 

eight resolution actions: Triage, 

Acknowledgement, Investigation, Post-Survey 

Contact, RO Action, SOD Issuance, Received 

to Closure, and Forward to Closure. 

Reports → Timeliness Reports

-

Tracking Report - SOD/POC TrackComplaint.rpt Shows SOD/POC (Statement of 

Deficiency/Plan of Correction) -related dates 

for intakes received within a specified time 

period.

Reports → Tracking Report SOD-POC

-

Complaint/Incident Volume By 

Week report

NumCompCumm.rpt Displays a bar graph of the total number of 

intakes received on each day of the week, 

totaled for each week.

Reports → Volume Reports → 

Complaint/Incident Volume by Week -
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Volume by Location Received - 

Detail report /                         

Volume by Responsible Team - 

Detail report

NoOfComplaints.rpt Displays the number of intakes received by 

day of month, sorted respectively by each 

location and responsible team.

Reports → Volume Reports → Details                  

→ Volume By Location Received                             

→ Volume By Responsible Team
-

Volume by Location Received - 

Summary report /                                 

Volume by Responsible Team  - 

Summary report

SummNumbBar.rpt Displays the number of intakes received by 

day of month, sorted respectively by each 

location and responsible team, in bar graph 

and text formats, including ranks and 

percentages.

Reports → Volume Reports → Summary               

→ Volume By Location Received                          

→ Volume By Responsible Team -

Weekly Summary report NumbCompWeek.rpt Displays the number of intakes received each 

day throughout the specified week for each 

responsible team in table form.

Reports → Volume Reports → Weekly Summary

-

Print Batched Letters Allows you to batch print letters, rather than 

printing each letter as it is created. You can 

list your batched letters only, or define a 

custom filter of work units/team, and ASPEN 

applications.

Report → Print Batched Letters

-

Transactions Report TransactionTracking.rpt Lists upload transactions for a specified 

period. There are numerous selection options 

for transactions, including an RO quick list of 

initial and flagged kits.

Tracking → Transactions → OK → PRINT

-

Intakes Requiring RO 

Authorization report

IntakesROAuth.rpt Displays only intakes received within a 

specified period of time for which RO 

authorization is required, including Deemed, 

EMTALA and D/R/S intakes.

Reports → Federal Only → Intakes Requiring 

RO Authorization
10.2

Facilities with Few (##) or No 

Intakes report

FacWoIntk.rpt Lists all facilities without any intakes, or with 

fewer intakes than the specified amount 

within the specified timeframe. 

Reports → Volume Reports → Facilities with 

Few or No Intakes 10.2

Investigation Survey Categories 

report

InvestCateg.rpt Displays a list of investigations grouped by 

survey categories for a specified timeframe.

Reports → Investigation Survey Categories

10.2

Investigation Deficiency Types 

report

InvestDefType.rpt Lists the type of deficiencies (condition, 

standard, or none), cited tags, and totals for 

all specified investigation surveys for each 

provider.

Reports → Deficiency Reports →  Investigation 

Deficiency Types
10.2

Federal Intake Volume by State 

(This report is only available for 

RO users.)

ACTSWorkloadEntries.rpt RO Mode Only. Displays daily workload 

entries for a specified timeframe for each 

state in the RO. Only Federal intakes are 

included.

Reports → Volume Reports → Federal Intake 

Volume by State
10.2
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AEM Reports (33 Total)

Action Items/Next Steps report EnfCaseNext.rpt Details action items, Federal and/or state next 

steps, and case statuses associated with 

selected facilities for selected date range.

Reports → Enforcement Reports → Action 

Items/Next Steps
-

Case Counts report EnfCaseCounts.rpt Basic report displaying case counts with 

various filter combinations, including date 

range, facility and case types, with a CDC 

case type option.

Reports → Enforcement Reports → Case 

Reports → Case Counts

Updated for 

CDC case 

type filtering 

in 11.9.3

Cases in Which No Letter Sent 

report                                           

(Cases For Which No Letter Has 

Been Sent)

EnfOpenCasesNoLetter.rpt Lists cases in which no letter has been sent 

to date, with the default First Date based on 

facility type. Basic report that allows SA/RO to 

focus on a key early processing step. The 

Cycle Start to Today count applies to task not 

yet completed as of current date: SA first 

letter, initial transfer to RO, or RO first letter.

Reports → Enforcement Reports → Case 

Reports → Cases in Which No Letter Sent            

*Available in RO mode to generate by region 

from Regional Reports.
Available as 

Regional 

Report in 

10.7

Cases Not Transferred to RO 

report

EnfCaseNotTxToRO.rpt Lists Enforcement cases that should have 

been transferred to the RO, but the Initial 

Transfer to RO field is not filled in, with the 

default First Date based on facility type. All 

Past Noncompliance cases meeting this 

criteria will appear, however. Verify current 

policy. Reformat the report layout to give 

Provider and Case specifics.

Reports → Enforcement Reports → Case 

Reports → Cases Not Transferred to RO                                  

*Available in RO mode to generate by region 

from Regional Reports.
Available as 

Regional 

Report in 

10.7

CLIA Enforcement Sanction 

Report                                                

(Only available when selection set 

includes CLIA facilities)

EnfCLIASanctions.rpt Prints report titled CLIA (Clinical Laboratory 

Improvement Amendments) Enforcement 

Sanction Log. Prints facility, survey, sanction, 

and registry information based on the filter 

screen.

Reports → Enforcement Reports → CLIA 

Enforcement Sanction Report

-

CLIA Enforcement Registry Report                                           

(Only available when selection set 

includes CLIA facilities)

EnfCLIARegistry.rpt Prints report titled CLIA (Clinical Laboratory 

Improvement Amendments) Enforcements 

Registry Log. Prints certificate status, 

sanction, and registry information based on 

the filter screen.

Reports → Enforcement Reports → CLIA 

Enforcement Registry Report

-
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CMPTS Case Profile report           

(Civil Monetary Penalty Tracking 

System)

CMPTSProfile.rpt RO mode only - From the CMPTS List 

window, select the specific facility for which 

you want to create a list, click MODIFY 

button, then click PRINT to view case details.

Tracking → CMPTS List

-

CMPTS List report                                   

(Civil Monetary Penalty Tracking 

System)

CMPTSList.rpt RO mode only - From the CMPTS List 

window, select PRINT button to create report 

that displays all facilities shown on the 

CMPTS List window, including Provider and 

Case specifics.

Available from either path:                                     

Reports → Enforcement Reports → CMPs → 

CMPTS List                                                                   

Tracking → CMPTS List

Reformatted 

in 10.7

Denial of Payment report EnfDenialPayment.rpt Prints enforcement cases with Denial of 

Payment remedies/sanctions and the related 

information, according to user-defined 

selection criteria. Reformat the report layout 

to give Provider and Case specifics.

Reports → Enforcement Reports → Remedies 

→ Denial of Payment                                  

*Available in RO mode to generate by region 

from Regional Reports

Available as 

Regional 

Report in 

10.7

Case Log report       (Enforcement 

Case Log)

EnfCaseLog.rpt A list of enforcement cases filtered and 

ordered by report filter selections, including, 

date range, facility and case type, with a CDC 

case type option.

Reports → Enforcement Reports → Case 

Reports → Case Log                                  

*Available in RO mode to generate by region 

from Regional Reports

Updated for 

CDC case 

type filtering 

in 11.9.3

Case Profile report                  

(Enforcement Case Profile)

EnfProfile.rpt Displays the currently selected Enforcement 

Case with the following information: Facility, 

Case Summary, Visit, IJ Situations, 

Remedies, Civil Money Penalty, Notice, 

NATCEP, Hearing, Case Workers, and Case 

Notes.

Reports → Enforcement Reports → Case Profile

-

Facility Enforcement History report EnfFacHist.rpt Lists a summary of all enforcement cases for 

the selected facility within a specified date 

range, including case dates, type and status, 

surveys, remedies and hearing information

Reports → Enforcement Reports → Facility 

Enforcement History

-

Enforcement Transactions Report TransactionTracking_Enf.rpt Lists facility and enforcement case details for 

all transactions in the selected time frame.

Tracking → Transactions → All Transactions for 

Specified Period (Enforcements) -
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Federal CMP Analysis report EnfCMPAnalysis.rpt Lists Federal Civil Monetary Penalties 

(CMPs) for the selected criteria, including 

Facility information, CMP Tracking System 

(CMPTS) #, Cycle Start Date and relevant 

CMP information.  There is a comprehensive 

summary section that can be printed for 

analysis of CMP trends. Reformat the report 

layout to give Provider and Case specifics.

Reports → Enforcement Reports → CMPs → 

Federal CMP Analysis                                  

*Available in RO mode to generate by region 

from Regional Reports
Available as 

Regional 

Report in 

10.7

Federal CMP Due report EnfCMPDue.rpt Details the total Federal Civil Monetary 

Penalty (CMP) amount due and the related 

CMP information for each enforcement case 

with Federal CMP(s) that have not been paid 

in full yet. Reformat the report layout to give 

Provider and Case specifics.

Reports → Enforcement Reports → CMPs → 

Federal CMP Due                                           

*Available in RO mode to generate by region 

from Regional Reports

Available as 

Regional 

Report in 

10.7

Federal/State CMP Tracking 

report

EnfCMPTrack.rpt Lists important civil Monetary Penalty (CMP) 

information for the selected criteria, which is 

useful for the every day tracking and 

processing of CMPs at the state level

Reports → Enforcement Reports → 

Federal/State CMP Tracking

-

G+ Enforcement Report - Phase 1 

and Phase 2

AEM: EnfImmImpReqRem.rpt Lists surveys at S/S G level or above, relating 

to regulations for Long Term Care Facilities - 

Fed-F-16.01.

Reports → Enforcement Reports → Remedies 

→ G+ Enforcement Report - Phase 1 and Phase 

2

*Available in RO mode to generate by region 

from Regional Reports

Reports → Regional Reports → G+ Enforcement 

Report - Phase 1 and Phase 2 → Generate 

Report → Select Facility Type → OK → View

11.3

IDR Processing Times report IDRProcessingtime.rpt Prints dates related to the Informal Dispute 

Resolution (IDR) process for surveys that 

have IDR, and gives the total number of days.

Reports → Enforcement Reports → IDR 

Processing Times
-

IDR/IIDR Report IDRDetail.rpt Lists enforcement cases with Informal 

Dispute Resolution (IDR) and Independent 

Informal Dispute Resolution (IIDR) activity. 

Includes filters for date range, facility and 

case type, with CDC case type option.

Reports → Enforcement Reports → Ancillary 

Reports → IDR/IIDR Report                            

*Available in RO mode to generate by region 

from Regional Reports

Updated for 

CDC case 

type filtering 

in 11.9.3
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Immediate Jeopardy Timeline 

report

EnfJeopardyTimeline.rpt Displays IJ case timeframes between IJ 

discovery and compliance.

Reports → Enforcement Reports → Immediate 

Jeopardy Timeline                                  

*Available in RO mode to generate by region 

from Regional Reports.

-

Mandatory DPNA Timeline report EnfDCTimeline.rpt Lists cases with Denial Payment for new 

Admissions (DPNA) remedies and the 

relevant data for denial of payment. Available 

filters include, time period, S/S range, case 

worker, and only cases within 14 days of 70th 

day.

Reports → Enforcement Reports → Mandatory 

DPNA Timeline                                       

*Available in RO mode to generate by region 

from Regional Reports..
-

Medicare Hearing Status report EnfHearingStatus.rpt Lists cases with Medicare hearings and their 

current status.

Reports → Enforcement Reports → Medicare 

Hearing Status
-

NATCEP Loss report EnfNATCEPLoss.rpt Lists cases with Nurse Aide Training and 

Competency Evaluation Program (NATCEP) 

loss data, primary loss reason, effective date, 

last day of loss state waiver effective date 

and CHOW restart date.

Reports → Enforcement Reports → NATCEP 

Loss

-

State CMP Due report EnfStCMPDue.rpt Prints the total State Civil Monetary Penalty 

(CMP) amount due and the related CMP 

information for each enforcement case with 

state CMP(s) that have not been paid in full 

yet.

Reports → Enforcement Reports → State CMP 

Due

-

Survey IDR/IIDR Detail report IDRDetaiOneSurveyl.rpt Prints IDR/IIDR information related to the 

associated survey.

Informal Dispute Resolution - IDR for Survey 

window → Print button
-

Surveys Not in an AEM Case 

report

EnfSurveyNotInCase.rpt Lists surveys not currently attached to an 

enforcement case. Allows user to configure 

for date range, survey type,  and 

scope/severity, with the default First Date 

based on facility type.                                                                                                                                                                                                                               

Enlarge / correct the Report Selection screen 

to show all fields. (Currently, some fields are 

cut off.) Reformatted, for easier viewing.

Reports → Enforcement Reports → Case 

Reports → Surveys Not in an AEM Case                               

*Available in RO mode to generate by region 

from Regional Reports. Available as 

Regional 

Report in 

10.7

Termination report EnfTermination.rpt This report prints enforcement cases with 

termination remedies/sanctions and the 

related information, according to the selected 

report filters.

Reports → Enforcement Reports → Remedies 

→ Termination                                           

*Available in RO mode to generate by region 

from Regional Reports.

Available as 

Regional 

Report in 

10.7
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Waiver Report AEMWaivers.rpt Lists enforcement cases with citations citing 

waivers defined by the selected criteria.

Reports → Enforcement Reports → Waiver 

Report -

Cases Not Uploaded report (AEM 

Enforcement Cases Not 

Uploaded)

AEM:EnfCasesNotUploaded.rpt Lists cases never successfully uploaded to 

National, have their first upload pending for 

tonight, and that have been previously 

uploaded but had a "Delete from National" 

with no subsequent successful uploads. Also 

includes the highest S/S for the first visit and 

the whole case cycle. The number of days 

uses the difference between cycle start and 

end dates.

Reports → Enforcement Reports → Cases Not 

Uploaded

10.3

CMP Analytic Tool Report AEM:EnfCMPAnalyticTool.rpt Lists current and potential CMP cases, with 

the information used by the CMP Calculation 

Tool to calculate CMP amounts. Allows users 

to configure by case status, SA/RO primary 

worker, facility type, case type, and date 

range, and helps ROs track how CMPs are 

calculated.

Reports → Enforcement Reports → CMP 

Analytic Tool Report

10.5

Repeat Deficiency Cases Report AEM:EnfRepDefs.rpt Lists cases with repeat deficiencies. Includes 

CCN, provider name, enforcement case ID, 

current and prior survey dates, the repeated 

deficiency with related S/S, and whether the 

repeated deficiency is worse, the same, or 

improved.

Reports → Enforcement Reports → Survey 

Citations → Repeat Deficiencies Cases Report                                                        

*Available in RO mode to generate by region 

from Regional Reports

Available as 

Regional 

Report in 

10.7

Special Focus Facilities report SpecialFocusFacility.rpt Lists facilities based on the Special Focus 

periods entered in the Facility Properties 

window Other tab. Includes the facility name, 

ID, CCN, and address, as well as the special 

focus period date range.

Reports → Enforcement Reports → Survey 

Citations → Special Focus Faclities      

*Available in RO mode to generate by region 

from Regional Reports

Available as 

Regional 

Report in 

10.7

CMS 2567 Sent to Facilities report CMS2567SentToFac.rpt Lists surveys by facility with the survey event 

ID, exit date, and type, with the number of 

days since the exit date the CMS 2567 form 

was sent to the facility. Surveys with no 2567 

sent to facilities can also be listed. Includes 

facility name, address, ID, CCN, state key, 

and license number.

Reports → Enforcement Reports → Survey 

Citations →CMS 2567 Sent to Faclities       

*Available in RO mode to generate by region 

from Regional Reports

Available as 

Regional 

Report in 

10.7
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AEM Reports - Draft Reports (16 Total)

Checks Received report EnfChecksReceived.rpt Lists facility, enforcement case, and cycle 

information, as well as check amount and 

date received.

Reports → Enforcement Reports → Draft 

Reports → Checks Received -

Cases Closed report                       

(Closed Cases Report)

EnfClosedCases.rpt List of closed cases, with facility and date 

information.

Reports → Enforcement Reports → Draft 

Reports → Cases Closed
-

CMPs Paid report EnfCMPPaid.rpt Lists Civil Monetary Penalty (CMP) amounts 

and dates collected according to user-

specified selection criteria.

Reports → Enforcement Reports → Draft 

Reports → CMPs Paid -

Compliance Issues (Detail) report EnfComplianceIssues.rpt A list of cases showing the timeline of the 

state's 1st visit, sending to the RO, total 

number of visits and the interval between 

cycle start and compliance dates.

Reports → Enforcement Reports → Draft 

Reports → Compliance Issues
-

NATCEP Current report                 

(Facility Quick List)

FacilityList.rpt Prints Facility Quick List, including facility 

address and contact information.

Reports → Enforcement Reports → Draft 

Reports → NATCEP Current
-

All Pending Remedies report 

(Pending Remedy Counts - Detail)

EnfAllPendingRemedy.rpt Lists counts of all remedies with a current 

Pending status.

Reports → Enforcement Reports → Draft 

Reports → All Pending Remedies -

Remedy Counts Detail report 

(Pending Remedy Counts – Detail)

EnfPendingRemedy.rpt Lists details of select remedies that have a 

current Pending status.

Reports → Enforcement Reports → Draft 

Reports → Remedy Counts Detail -

(Pending) Remedy Counts 

Summary report 

EnfPendingRemedySummary.rpt Summary counts and details of pending 

remedies for the selected report criteria.

Reports → Enforcement Reports → Draft 

Reports → Remedy Counts Summary 
-

OMR: Pend. Terminations report 

(Pending Terminations Report)

EnfPendingTermination.rpt Lists cases that potentially are going to be 

terminated (Remedy 11B -  Mandatory 

Termination), and dates for the terminations.

Reports → Enforcement Reports → Draft 

Reports → OMR: Pend. Terminations
-

OMR: RO Early Proc. Times 

report                                               

(RO Early Processing Times – 

Detail Report)

EnfEarlyProcess.rpt Displays Office of Medical Review (OMR) 

facility and enforcement case information, 

and RO processing times by provider, 

according to user-defined selection criteria.

Reports → Enforcement Reports → Draft 

Reports → OMR: RO Early Proc. Times

-
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RO Multi Processing Times 

(Detail) report

EnfMultiProcess.rpt Lists cases on which the RO is working, with 

timeframes from sending notices, and 

performing revisits to closure.

Reports → Enforcement Reports → Draft 

Reports → RO Multi Process Times -

OMR: RO-SA Early Proc. Times 

report                                                      

(RO State Early Processing Times 

- Detail Report)

EnfStateEarlyProcess.rpt Lists Office of Medical Review (OMR) 

timeframes for SA and RO processing of 

enforcement cases

Reports → Enforcement Reports → Draft 

Reports → OMR: RO-SA Early Proc. Times
-

SA Perf. Eval: 6 Month 

Compliance report

EnfSAPerfEval.rpt Lists facility and initial visit information for 

cases without compliance by the 90th and 

160th day of the case, as well as the 6 month 

termination date, for SA Performance 

analysis of compliance processing.

Reports → Enforcement Reports → Draft 

Reports → SA Perf: 6 Month Compliance

-

SA Perf: IJ Process report             

(SA Perf Eval: IJ Term. Process)

EnfIJTermProcess.rpt Lists cases with Immediate Jeopardy (IJ) 

situations, including initial and IJ visits, for 

State Agency Performance analysis of IJ 

processing

Reports → Enforcement Reports → Draft 

Reports → SA Perf: IJ Process
-

State Visit Processing Times 

(Detail) report

EnfStateVisit.rpt Displays facility enforcement cases and the 

intervals between visits for the case, and the 

intervals between visits for the case and the 

RO Received date.

Reports → Enforcement Reports → Draft 

Reports → State Visit Processing Times
-

OMR: Term. Facilities report 

(Terminated Facilities Report)

EnfTerminatedFacilities.rpt Lists information for all the terminated 

facilities based on the report selection criteria, 

including process beginning, end and visit 

dates.

Reports → Enforcement Reports → Draft 

Reports → OMR: Term. Facilities
-
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CLIA (7 Total)

CLIA 116 Application List report CLIA116AppList.rpt Provides CLIA 116 application information, 

including CLIA number, lab information, SA 

received and 116 complete dates, added by 

name, paid in full and upload status, and type 

of application for selected date range.

Reports → CLIA Reports → CLIA 116 Application 

List

-

CLIA Laboratory Profile Report CLIALabSrchList.rpt Displays a list of all CLIA laboratories that 

match the specified report selection criteria, 

including facility, director, and certification 

information.

Reports → CLIA Reports → CLIA Laboratory 

Profile Report
-

CLIA Nightly Facility Update report CLIANightlyFacilityUpdate.rpt Shows facility changes made in CLIA applied 

to provider records in ASPEN by the nightly 

extract process.

Reports → CLIA Reports → CLIA Nightly Facility 

Update -

No. of Sites Mismatch report 

(Number of Sites Mismatch 

Report)

CLIANoSitesMismatch.rpt Displays a list of all CLIA laboratories where 

the number of sites entered does not match 

the value entered in the Number of Sites field.

Reports → CLIA Reports → No. of Sites 

Mismatch
-

QC Exclusion report CLIAQCExclusion.rpt Lists all Quality Control (QC) exclusion tags 

assigned during a specified date range.

Reports → CLIA Reports → QC Exclusion

-

Discrepancy report (Validation 

Survey Discrepancy Report)

CLIADiscrepancy.rpt Lists CLIA labs with discrepancies in specialty 

data found during a validation survey.

Reports → CLIA Reports → Discrepancy

-

Workload Monitoring report (CLIA 

Workload Monitoring)

CLIAWorkloadMonitoring.rpt Provides total counts and survey information 

for survey categories for a specified date 

range.

Reports → CLIA Reports → Workload 

Monitoring -
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CMS Forms (31 Total)

CMS-29 Form29.rpt Provides facility name, address, type, phone, 

email, and active date information for a 

selected administrator.

Certification Sheet → App/CDE (CMS-29/30E)  

→ PRINT -

CMS-30E Form30E.rpt Rural Health Clinic Survey Report - Crucial 

Data Extract

Certification Sheet → App/CDE (CMS-29/30E)  

→ PRINT
-

CMS-359 Corf359.rpt Comprehensive Outpatient Rehabilitation 

Facility Report for Certification to Participate 

in the Medicare Program

Certification Sheet → Application (CMS-359) → 

PRINT -

CMS-377 Form377.rpt Ambulatory Surgical Center Request for 

Certification in the Medicare Program

Certification Sheet → App/CDE (CMS-377/378E) 

→ PRINT
-

CMS-378E Form378ee.rpt Ambulatory Surgical Center Survey Report 

Crucial Data Extract

Certification Sheet → App/CDE (CMS-377/378E) 

→ PRINT
-

CMS-417 Hospice_417.rpt Hospice Request for Certification in the 

Medicare Program

Certification Sheet → Application (CMS-417) → 

PRINT
-

CMS-562 Form cms562.rpt Medicare/Medicaid/CLIA Complaint Form Intake Sheet → Deemed tab → PRINT CMS 562 

Form
-

CMS-643 Hospice643.rpt Hospice Survey and Deficiencies Report Certification Sheet → Application (CMS-643) → 

PRINT
-

CMS-670 FORM CMS-670 Survey Team Composition and Workload 

Report

Survey Node → Print Form → CMS 670
-

State Workload Report oSt670.rpt Presents all of the state workload information 

entered on the CMS-670 form for a selected 

survey, showing specifically the total hours for 

each surveyor on the survey team and the 

total office hours that were entered for that 

survey.

Survey Node → Print Form

-

670 Summary (670s) o670SummaryWithoutGroupBySurvey.rpt Lists surveys during the specified period of 

time in alphabetical order by facility for 

selected regulation sets. Survey team size, 

exit date, and personnel hours for each 

survey are included in the report.

Reports → Survey History Reports → 670 

Summary (670S)

-

670 Summary (670S) o670Summary.rpt Lists surveys during the specified period of 

time by survey type for selected regulation 

sets. Survey team size, exit date, and 

personnel hours for each survey are included 

in the report.

Reports → Survey History Reports → 670 

Summary (670S) – With Group By Survey Type 

option selected -
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CMS-671 LTC671Application.rpt Long Term Care Facility Application for 

Medicare and Medicaid

Certification Sheet → Application (CMS 671)  → 

PRINT
-

CMS-672 Census672.rpt Resident Census and Conditions of 

Residents

Certification Sheet → Census (CMS-672) → 

PRINT
-

CMS-1539 o1539.rpt Medicare/Medicaid Certification and 

Transmittal

Certification Sheet → Transmittal (CMS-1539)   

→ PRINT
-

CMS-1541A FORM CMS-1541A Request for Survey of Section 489.20 and 

Section 489.24 Essentials of Provider 

Agreements

Intake Sheet → Deemed tab → PRINT CMS 

1541A Form -

CMS-1541B FORM CMS-1541B Responsibilities of Medicare Participating 

Hospitals in Emergency Cases Investigation 

Report

Intake Sheet → Deemed tab → PRINT CMS 

1541B Form -

CMS-1557 ohfca1557.rpt Survey Report Form (CLIA) Certification Sheet → Survey (CMS-1557)  → 

PRINT
-

CMS-1572A ohcfa1572.rpt Home Health Agencies Survey and 

Deficiencies Report

Certification Sheet → Application (CMS-1572A)  

→ PRINT
-

CMS-1856 Form1856.rpt Request for Certification in the Medicare 

and/or Medicaid Program to Provide 

Outpatient Physical Therapy and/or Speech 

Pathology Services

Certification Sheet → Application (CMS-1856)   

→ PRINT
-

CMS-1880 Surv1880xray.rpt Request for Certification as Supplier of 

Portable X-Ray Services under the 

Medicare/Medicaid Program

Certification Sheet → Application (CMS-1880)   

→ PRINT -

CMS-1893E Form1893E.rpt Outpatient Physical Therapy Survey - Speech 

Pathology Report Crucial Data Extract

Obsolete (v8.7 per DTR-1755)

-
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CMS-2567 o2567.rpt Statement of Deficiencies and Plan of 

Correction

Survey Node → Print Form → CMS 2567
-

CMS-2567B o2567B.rpt Post-Certification Revisit Report Survey Node → Print Form → CMS 2567B -

CMS-2567 o2567Large.rpt Lists all of the tags cited for a particular 

survey  as well as all of the citation text that 

was entered for each tag.

Survey Node → Print Form

-

CMS-2567 oSt2567.rpt Lists all of the state tags cited for a particular 

survey  as well as all of the citation text that 

was entered for each tag.

Survey Node → Print Form

-

CMS-2567 oSt2567Large.rpt Lists all of the state tags cited for a particular 

survey  as well as all of the citation text that 

was entered for each tag.

Survey Node → Print Form

-

CMS-2786 Form                                     

(Fire Safety Survey Report)

Form CMS-2786 Fire Safety Survey Report Crucial Data 

Extract

Certification Sheet → LSC 2786 tab → PRINT 

2786 -

CMS-2802 hcfa2802.rpt Request for Validation of Accreditation 

Survey for Hospital. Other versions of report 

are available for Hospice (B), HHA ©, ASC 

(D), CAH (E), and Psychiatric Hospital (F).

Intake Sheet → Deemed tab → PRINT select 

form

-

CMS-3070G surv3070.rpt Intermediate Care Facility (ICF) for 

Individuals with Intellectual Disabilities (IID) 

Survey Report

Certification Sheet → Application (CMS-3070G) 

→ PRINT -

CMS-3427 Form3427.rpt End Stage Renal Disease 

Application/Notification and Certification 

Request

Certification Sheet → Application (CMS-3427)   

→ PRINT -
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ePOC Reports (15 Total)

Deficiency Free Surveys report epocSurveysDeficiencyFree.rpt Provides a list of surveys with no cited 

deficiencies for selected date range, including 

survey and facility information.

Reports → ePOC Management Reports → 

Deficiency Free Surveys -

Surveys Changed Since Posting 

report

ePOCSurvey.rpt Lists surveys that have been edited since 

original posting.

Reports → ePOC Management Reports →Re-

post Required Reports → Surveys Changed 

Since Posting

-

Deficiencies Not Posted report UnpostedDeficiencies.rpt Lists surveys with deficiencies, excluding tags 

removed/changed due to a 

settlement/hearing,  that have not been 

posted to ePOC.

Reports → ePOC Management Reports → Re-

post Required Reports → Deficiencies Not 

Posted
-

Stopped Surveys report epocStoppedSurvey.rpt Lists surveys that have been stopped. 

Includes facility in formation, event ID 

information, and survey and POC dates for 

selected date range.

Reports → ePOC Management Reports → 

Stopped Surveys
-

Unlocked Surveys report ePOCSurvey.rpt Lists surveys that are unlocked, including 

facility and survey ID information, with SOD 

sent and POC due dates for the selected date 

range.

Reports → ePOC Management Reports → 

Unlocked Surveys
-

Facilities Having ePOC Users 

report

FacPOCUsers.rpt Lists ePOC enabled facilities with assigned 

web users.

Reports → ePOC Management Reports → 

ePOC Web Users Reports → Facilities Having 

ePOC Users

Filterable by 

CCN

Facilities Pending SA/RO POC 

Review report

FacilitiesPendingSAROActivity.rpt Shows all facilities with newly submitted or re-

submitted POCs, excluding tags 

removed/changed due to a 

settlement/hearing, which are awaiting SA 

review.

Reports → ePOC Management Reports → 

Facilities Pending SA/RO POC Review

-

Facilities Without ePOC Users 

report

FacPOCUsers.rpt Lists ePOC enabled facilities without 

assigned web users.

Reports → ePOC Management Reports → 

ePOC Web Users Reports → Facilities Without 

ePOC Users

Filterable by 

CCN

Plan of Correction Audit Trail 

report

PlanOfCorrectionAuditTrail.rpt Shows all POC activities (submissions, re-

submissions, rejections, approvals, etc.) for a 

specific facility or group of facilities.

Reports → ePOC Management Reports → Plan 

of Correction Audit Trail
-
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Rejected Tags Requiring Facility 

Follow-up report

RejectedTagsRequiringFollowupPOC.rpt Shows all rejected deficiencies,excluding tags 

removed/changed due to a 

settlement/hearing, for which facilities have 

not re-submitted a POC within specified time 

frames

Reports → ePOC Management Reports  → 

Rejected Tags Requiring Facility Followup

-

SOD Acknowledgement Missing 

report

SODAcknowledgementMissing.rpt Shows all deficiency-free surveys for which 

the facility has not acknowledged review of 

the SOD, where acknowledgement is 

required.

Reports → ePOC Management Reports → SOD 

Acknowledgement Missing
-

Survey POC Information report SurveyPocInformation.rpt Displays detailed POC data, excluding tags 

removed/changed due to a settlement or 

hearing, as well as the following survey 

information: Event ID, SOD Sent Date, POC 

Due Date, POC Received Date (date of the 

first POC submission for any tag on the 

survey), POC Last Rejected Date (date of the 

last POC rejection for any tag of the survey), 

POC Final Approval (last approval date for all 

non-0000 tags on the survey), and Last 

Submitted (date of the last POC submission 

for any tag on the survey).

Reports → ePOC Management Reports → 

Survey POC Information

-

Tardy POC Submission From 

Facility report

NoPOCEverReceived.rpt Shows all deficiencies, excluding tags 

removed/changed due to a 

settlement/hearing, for which facilities have 

not submitted a POC within specified time 

Reports → ePOC Management Reports → Tardy 

POC Submission From Facility -

Tardy SOD Issuance report TardySODIssuance.rpt Shows all surveys (Excluding stopped 

surveys) not signed off within 10 days of 

survey exit date.

Reports → ePOC Management Reports → Tardy 

SOD Issuance -

ePOC Reports can exclude 

facilities without CCN

FacPOCUsers.rpt
Create list of reports that excludes facilities 

without a CCN

Reports → ePOC Management Reports  → 

ePOC Web Users Reports  → Failities Without 

ePOC Users

11.0.0
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